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关于 i-Tree（About i-Tree） 

i-Tree是来自美国林务局最先进的同侪评阅（peer-reviewed）软件套件，其提供

都市及小区林业分析与效益评估工具。i-Tree 工具藉由量化环境树木提供的服

务及评估都市林结构，以帮助各种大小的地区加强他们的都市林管理与推广

度。 

 

i-Tree已被小区、非营利组织、顾问、志工及学生用于记录各种规模的都市

林，从单一树木乃至小区、都市甚至整个国家。透过了解当地树木实际提供的

生态系服务，i-Tree使用者可连结都市林管理活动、环境质量及小区的可居住

性。无论研究目标为单一树木或整个森林，i-Tree的基础数据供你证明价值及

确定优先度以做更有效的决策。 

 

由美国林务局与众多合作伙伴共同开发，i-Tree设于公共网域上，可向 i-Tree网

站（www.itreetools.org）索取授权。林务局、Davey树木专家公司（Davey Tree 

Expert Company）、植树节基金会（Arbor Day Foundation）、市植树师学会

（Society of Municipal Arborists）、树木植栽国际协会（International Society of 

Arboriculture）以及 Casey Trees 皆已成为合作伙伴以利未来发展、传播与为此

套件提供技术支持。 

 

i-Tree产品（i-Tree Products） 

i-Tree软件套件 5.0版本包含以下各都市林分析工具及应用程序。 

 

i-Tree Eco 提供整个都市林的概况。其使用来自小区随机分布样区的现场数据

及当地每小时空气污染和气象数据，以量化都市林结构、环境影响与对小区的

价值。 

 

i-Tree Streets侧重于生态系服务及一个都市行道树族群的结构。它使用一个样

本或完整普查数据量化并将每棵树的年度环境与美学效益以美元价格计算，包

含节约能源、改善空气质量、减少二氧化碳、雨水控制及房地价增幅。 

 

i-Tree Hydro 是第一个针对植被的都市水文模型。其模拟都市林覆盖变更的影

响，及流域层不透水表面的每小时河流流量和水质。 

 

i-Tree Vue让你自由使用全国土地覆盖数据库（National Land Cover Database，

NLCD）的卫星图像以评估小区的土地覆盖，包含树冠及当前都市林提供的一

些生态系服务。其也可模拟种植方案对未来效益的影响。 

 

i-Tree Species Selector 是一个独立的工具，用于帮助都市林管理者根据环境功
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能和地理区域选择最适合的树种。 

 

i-Tree Storm帮助你在一场严重的飓风天灾过后，立即以简单、可靠又有效的

方式评估广泛的小区损害。它适用于各种小区类型及大小，并提供关于时间与

减轻灾害所需资金的信息。 

 

i-Tree Design 是一个简易的在线工具，提供一片树林中单一树木的评估平台。

此工具连接 Google地图，使你了解树木选择、树木大小及放置位置将如何影响

能源使用和其它效益。此工具仍在早期开发阶段，更多精密的功能选项会在未

来版本释出。 

 

i-Tree Canopy 提供一个快速简便的方法，透过使用适合的 Google Maps 航空图

像，产生土地覆盖类型（如，树木冠盖）的有效统计性的估计。透过使用这些

数据，都市林管理者可估计树冠覆盖、设立树冠目标，及顺利地进行追踪，且

能为 i-Tree Hydro 和其它需要土地覆盖数据的项目估计所需数值。 

 

免责声明（Disclaimer） 

本出版物中所使用之商品、商号或公司名称仅为提供读者信息和便利，并非排

除其它可能适合之任何产品或服务的使用方式，所提及之商品、商号或公司名

称也非受到美国农业部或林务局的官方认可或批准。标签「i-Tree Software Suite 

v. 5.0」所发布之软件，将不提供任何形式的担保。它的使用受到最终用户许可

协议（End User License Agreement，EULA）管辖，使用者在安装前需先同意接

受该协议。 

 

回馈（Feedback） 

i-Tree开发团队积极寻求关于此产品的任何回馈意见：软件套件、使用手册，

或是开发、推广、支持和精细化的过程。请将评论根据 i-Tree支持页面所列出

的方式寄送：http://www.itreetools.org/support/ 

  

http://www.itreetools.org/support/
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介绍（Introduction） 

Streets（源自专为都市林管理人量身打造的行道树资源分析工具，Street Tree 

Resource Analysis Tool for Urban Forest Managers，STRATUM）是一个容易上手

的软件工具，特别着重于都市行道树，供任何小区记录及评估都市树木的效

益。此分析提供基础数据以改善都市树木的管理，并帮助小区得到计划的支持

与资金。Streets 在以下方面评估行道树林： 

 

Structure（结构）：Streets 会描述物种组成、年龄分布、物种重要性价值

与都市林树冠覆盖，帮助管理人预估未来种植的需求及病虫害威胁的影

响。 

 

Function（功能）：Streets 的核心能力可分析都市林生态系服务，也就是

该都市林的功能，包含节能、空气质量改善、雨水管理与二氧化碳减

量。因市容美化而提升的地产价值及其它效益也将被计算。 

 

Values（数值）：Streets 量化都市林提供的环境及其它效益，不管是单位

方面（像是每小时可节约千瓦的电力）或金钱方面。管理成本也可包含

至分析内，以确定树木的投资报酬率。 

 

Management needs（管理用处）：如果你决定收集关于树木状况、维护

需求、公共建设冲突或病虫害威胁等数据，Streets 的报告可帮助你将此

信息运用于树木管理及预算规划等事务。 

 

使用由 Streets 提供的报告及信息将可帮助你： 

1) 藉由了解哪些树种可将树冠最大化、为小区带来重要效益，提高投资的

回报率。 

2) 确定你都市林的管理需求以维护并改善树木健康。 

3) 促进合作伙伴的投资，例如能源节约及减碳。 

4) 透过提高小区生活质量，证明树木的价值并获得公众支持。 

5) 利用年度预算与支出费用数据，对树木表现进行经济评估。 

6) 预估管理成本──不单只是效益──以提供一个规划策略平台。 

 

由于在设计上较为弹性且具高调整性，Streets 不需以 GIS 为基础，只需基本的

数据库数据。Streets 的数据库程序、PDA应用程序或具网络基础功能的智能型

手机，皆可用于小区的样本或完整行道树普查数据。此外，Streets 可利用任何

现有的行道树普查数据，只要有物种和胸高直径数据。数据需照 Streets 的规范

格式化。 

 

所产生的报告可针对整个城市、管理区或特定物种。Streets 使用地区树木生长
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模型及地区默认成本和效益，且可依照地区要求设定。无论欲保护现有树木或

增加预算，Streets 可针对你的树木计划提供量化依据。你将能回答关于树木规

划计划最重要的问题，像是行道树的累积效益是否超过其管理成本？ 

 

最先进的研究为 Streets 效益报告提供科学基础。维护行道树的效益与成本资料

来自扩展研究与 16个国家型气候的实验模拟。更多关于研究方法的信息，请参

考此网站（www.itreetools. org）所发表的一系列对应不同气候地区的树木指南

（Tree Guides）。 

 

关于本手册（About This Manual） 

本手册提供建立 Streets 项目所需的所有信息。我们从安装软件开始，之后会介

绍四个项目阶段： 

 

第一阶段：开始进行（Phase I: Getting started）。在本节中，我们讨论需要于 

一开始做出的决定，例如是否将使用现有的普查数据或另建立新的普查数据，

以及新普查数据为街道区段的随机样本或所有树木的完整普查数据。第一阶段

也包含你需列入考虑或已持有的一般数据收集，像是都市预算信息、地段效益

价格与普查数据的道路名称清单。在此阶段，你将规划你的普查数据，无论是

决定欲收集的数据项、定义数据项的类别，或根据 Streets 的要求重新组织现有

的普查数据。若有需要，最后的步骤则是建立一个样本普查数据。 

 

第二阶段：开始执行软件（Phase II: Getting started with the software）。在此

阶段，我们会使用 Streets 软件输入在第一阶段所收集的数据、设定我们的普查

数据，并设定 PDA应用程序或智能型手机/平板计算机功能，以利持有这些工

具的研究者使用。 

 

第三阶段：实地调查（Phase III: Out in the field）。在此阶段是所有阶段最困难

的，因为你将派普查人员到现场收集资料并传回普查数据。本章节着重于使用

具有网络的行动装置，像智能型手机、平板计算机或 PDA。 

 

第四阶段：回到你的办公桌：执行 Streets（Phase IV: Back at your desk: 

Running Streets）。在此章节，我们会描述如何运行软件以得到结果。首先，我

们会从纸张表格、智能型手机、平板计算机或 PDA传送数据至桌机，或上传现

有普查数据，并讨论应如何修改普查数据及如何再次检查这些实地数据。最

后，本章节涵盖了所有可用的报告，并说明应如何储存、输出及打印计算结

果。 

 

附录一：随机抽样工具书（Appendix I：Random Sample Workbook）。如果你



8 

 

在建立一个样本普查数据，附录一将提供你使用 ArcGIS 软件产生随机街道区

段的其中一种方法的详细步骤。 

 

附录二：错误排除（Appendix II：Troubleshooting）。这几年内，我们注意到

几个 Streets 使用者的常见错误。此附录说明它们如何发生及应如何解决。 

 

附录三：病虫害检测调查表输出格式（Appendix III：Formatting Pest Protocol 

Data for Import）。此表格将呈现与 IPED病虫害评估检测相关的数据项及类

别。 
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安装（Installation） 

 

系统需求（System Requirements） 

桌上型/笔记本电脑的需求（Requirements for desktop/laptop computers） 

最低硬件（Minimum hardware）： 

 1600 MHZ或是更快的处理器 

 512 MB可用内存 

 至少 500MB的可用硬盘空间 

 

软件（Software）： 

 Windows 操作系统 XP SP2或更高（包含Windows 7） 

 Microsoft Excel 

 Microsoft Data Access Component (MDAC） 2.8 或更高（包含于 i-Tree

安装内） 

 Microsoft .NET 2.0 Framework（包含于 i-Tree 安装内） 

 Adobe Reader 9.0 

 针对 PDA使用者，Windows XP 需 ActiveSync 4.5 或更高，Vista与

Windows 7 需Windows Mobile 装置中心或更高（包含于 i-Tree安装内） 

 Crystal Report 2008 Runtime（包含于 i-Tree安装内） 

 

实地数据收集仪器的需求（Requirements for field data collection devices） 

智能型手机、平板计算机及其它具网络功能的行动装置： 

 网络浏览器要有 HTML-5的兼容性（最新版本的 Chrome、Firefox 和

Safari；IE9和 10则有限制） 

 

对于兼容性装置的更新列表，请参阅 i-Tree论坛（forum.itreetools.org）。 

 

PDA（地理信息系统）： 

 Windows Mobile 5.0-6.5操作系统 

 240*320 的屏幕分辨率 

 

GPS 装置需求（Requirements for GPS devices） 

在 i-Tree Streets 项目中收集 GPS 坐标信息是非必需的。具 GPS 功能、执行

Windows Mobile 5.0-6.5操作系统的装置，或具兼容性并配对 NMEA蓝芽的装

置，或一系列的 GPS 装置皆可能被使用。 

 

i-Tree Streets 使用者已成功使用 Trimble Juno SB、Trimble Nomad、Pharos 

Traveler 525 和 MWg Zinc II。然而，GPS 装置的功能有所不同，装置之间的操
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作效果也各有差异。举例而言，Pharos m619 GPS 不适用于 Streets，因此目前不

建议使用。 

 

你也可使用智能型手机或平板计算机的 GPS 功能。 

 

安装（Installation） 

1) 进入此网站（www.itreetools.org）下载软件，或将 i-Tree软件安装光盘放

入 CD/DVD 光驱中。 

2) 按照屏幕的指示执行 i-Tree setup.exe档案。根据所需的安装档案不同，

这将花几分钟的时间。 

3) 按照安装小精灵的指示以完成安装（建议安装在默认路径）。 

 

你可以藉由点击 Help > Check for Updates 随时检查最新的更新。 

 

使用范例项目探索 Streets（Exploring Streets with the Sample 

Project） 

现在你已经安装完 Streets，你将看到一个软件图标，点击后即可执行 Streets。

为了让你探索此程序，我们内建了加州戴维斯（Davis, CA）行道树的随机抽样

普查数据的范例项目。此外，若你对病虫害检测模型的报告功能有兴趣，一个

IPED范例项目也有内建。 

1) 使用你计算机上的开始选单 > 所有应用程序 > 选择 i-Tree > 点击 i-

Tree Streets以开启 Streets。 

2) 你将在此路径 File > Open > Sample Project 找到该范例项目。 

 

在 Input 选单中，你将看到关于你的普查数据、你的城市基本信息、预算成本

与效益价值的许多自定义字段。在 View 选单内，你可以切换英制和公制单

位，以及学名与俗名。在 Reports内，你可以检索效益、结构、更换成本及病

虫害报告。我们当然会深入解释全部功能，但现在请先自由探索这些可用的选

项。 

  

http://www.itreetools.org/
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第一阶段：开始进行（Phase I: Getting Started） 

 

前期规划决策（Early Decisions to Be Made） 

开始使用 Streets 工作之前，你必需做出一些决定。在本节中，我们会说明各选

项的一些优缺点以帮助你做出决定。 

 

你有一个现有普查数据，或需另建一个吗？（Do you have an existing inventory 

or will you need to conduct one?） 

如果你的小区已有一个最近建立的树木普查数据，且其至少包含树种及胸高直

径数据，你可将其直接运用于 Streets。该普查只需依 Streets 的最低需求格式

化，并储存为一个 Microsoft Access 数据库。之后的〈普查数据规划〉将详细说

明所需结构。补充指南书《Formatting Existing Inventories into Streets》以及输入

现有普查数据至 Streets 的相关资源，可在此网站（www.itreetools.org）的

Resources > Archives 路径找到。 

 

已有现有普查数据的小区需注意两个额外事项。第一，如果你只有一个样本普

查数据（也就是说，你只测量了部份树木，而非整座都市的树木），它必需是简

单随机抽样，否则其将无法在内建的模式下执行。第二，Streets 提供你都市林

效益与结构的实时概况。如果你的普查数据不是最新的，你所得到的结果将无

法反应现在的状况，因此你应考虑建立一个新的普查数据。 

 

如果你需要建立一个新普查数据，你会测量你研究区域内的每一棵行道树还是

进行随机抽样？（If you need to conduct an inventory, will you measure every 

street tree in your study area or carry out a random sample?） 

如果你没有普查数据，你必需建立一个。此普查可以是一个完整普查数据，至

少涵盖小区内所有行道树的树种及胸高直径，或是一个抽样普查数据。在抽样

普查数据中，街道区段（或线性样区）按照统计学的随机抽样规则选择，所有

被选择地段的行道树都会记录至普查数据中。抽样普查数据一般包含整体街道

样本的 3到 6%，取决于小区大小及街道之间的差异。此抽样通常会产生 10%

的全市树木个数标准偏差。 

 

一个完整的普查数据为你的都市林提供更全面的概况，也是日常工作和未来规

划的良好基础。另一方面，抽样普查数据更快、更便宜，且可提供基本数据以

供决策需求，但通常不能用于每日的管理作业。你必需衡量小区的资源与需

求，以决定哪种普查数据较为适合。 

 

如果需要一个新普查数据，你将使用（a）智能型手机、平板计算机或其它具网

络功能的行动装置（b）Streets PDA 工具（c）手动输入数据的纸制表格，何种

方式收集 Streets相关数据？（If a new inventory is needed, will you collect data 

http://www.itreetools.org/
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using (a) the Streets webform on a smartphone, tablet, or other web-enabled mobile 

device, (b) the Streets PDA tool, or (c) paper forms for manual data entry?） 

i-Tree v5.0 包含一个非常重要的更新：普查数据现在可以在具网络的智能型手

机及平板计算机（以下简称为行动装置）上建立。Streets 行动装置功能不是从

商店下载的 app，它是一个基于网络的普查数据收集表格。这意味着该功能只

要求装置的网络浏览器能与 HTML 5 兼容。兼容的浏览器包括最新版的 Chrome

和 Firefox（Android 安卓手机及平板计算机），Safari（iPhone和 iPad），以及

Internet Explorer 9和 10（Windows 手机和平板计算机）。IE浏览器在脱机缓存

上有能力限制──收集数据时，用户必需保持网络联机。因此，如果使用 IE，

你应准备经常将数据从你的行动装置传送到服务器，并了解若是失去数据连

接，最近一次的上传作业将失败，所有数据都将同时遗失。 

 

有关兼容装置的最新列表，请参阅 i-Tree论坛（http://forum.itreetools.org）。 

 

除了行动网络表格之外，Streets v5.0 将持续支持使用 PDA建立普查。PDA应

用程序跟 Streets 十分相像。它可以按照你的城市普查需求调整、易于使用，只

要点击一下即可上传数据。PDA应用程序能在各种运行Windows Mobile 5.0-6.5

操作系统的手持装置执行。有关兼容装置的最新列表，请参阅此网站

（www.itreetools.org）Resources > Manuals and Workbooks 内的〈System 

Requirements and Installation Document〉。 

 

如果你的团体缺少使用 PDA或行动装置的经费，或你想使用另一种方法，那也

可以。普查可以用纸制表格、专门的普查工具、电子表格等建立。使用易于操

作的数据输入表格，纸制表格的树木数据可以直接输入到 Streets 中。用其他方

式建立的普查，最后必需以特定格式储存成一个 Microsoft Access 数据库。你可

以复习之后的〈普查规划〉章节，了解规划普查所需的资料种类。 

 

收集一般资料（Gathering General Data） 

Streets 可以为你的都市自定义许多信息，包含效益价格（例如 1千瓦小时电力

或 1吨二氧化碳的价格）、预算数据以及都市基础建设信息。某些字段，例如效

益价格，Streets 已替你的地区内建默认数据，该数据可被编辑以符合你的小

区。其它字段可自行选择是否输入数据，增加数据字段将产生更有用的结果。

在本节中，我们将说明自定义字段，提供工作表以帮助你收集信息。以下的每

个工作表代表一个 Streets 数据输入窗口，也是最后输入数据之处。 

 

定义都市信息（Define City information） 

Streets 将记录平均收益和成本，并计算几个关于树冠的数值。如果你对此讯息

感兴趣，使用 Define City（都市定义）工作表收集必要的信息。 

 

http://forum.itreetools.org/
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都市定义工作表：Total municipal budget（总市政预算）、Population（人口）、Total land 

area（总土地面积，单位平方英里）、Average sidewalk width（人行道平均宽度，单位

英尺）、Total linear miles of streets（总行道长度，单位英里）、Average street width（行

道平均宽度，单位英尺） 

 

定义成本信息（Define Costs information） 

透过使用基本普查讯息，Streets 会计算你的都市林所提供的效益。为了算出此

效益的效益成本比率（一个有价值的公共政策工具），需要全市行道树管理的相

关成本数据。如果你对比较你都市林之效益与成本感兴趣，使用 Define Public 

Costs（定义公共成本）工作表收集必要的信息。由于效益为年度总结，全市行

道树管理的相关成本数据也应是年度值。别忘记包含其他部门的树木相关成

本，如人行道的维修费用或诉讼费用。 

 

有些小区希望分开公共与私人树木的成本费用，分别计算效益成本比率。例

如，由地产拥有者付费维护的公共道路树木，与使用公有资金维护的公共道路

树木。如果你将在普查中区分公共及私人树木，你可以使用 Define Costs（定义

成本）工作表的 Private Costs（私人费用）字段，以估算私人树木的成本。 

 

 

定义成本工作表：Annual planting（年度种植）、Annual pruning（年度修剪） 
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定义成本工作表：Annual tree and stump removal and disposal（年度树木及残干的移除

与处理）、Annual pest and disease control（年度病虫害防治）、Annual 

establishment/irrigation（年度种植与灌溉）、Annual price of repair/mitigation of 

infrastructure damage（年度维修/缓解基础建设损坏的价格）、Annual cost of litter/storm 

clean-up（年度废弃物及风暴后的清理费用）、Average annual litigation and settlements 

due to tree-related claims（年度与树相关的诉讼及财产授予之平均索赔）、Annual 

expenditure for program administration（年度计划实行的支出）、Annual expenditures for 

inspection/ answer service requests（年度检查/客服支出）、Other annual expenditures（其

它年度支出） 

 

定义效益价格讯息（Define Benefit Prices info） 

Streets 内建单位价格以计算你所在地区之都市林效益。我们鼓励你更新部份或

全部的效益价格以符合当地的市场状况。使用 Define Benefit Prices（定义效益

价格）工作表收集信息。 
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定义效益价格工作表：Electricity （电力，$/kWh）、Natural gas（天然气，$/therm）、

CO2（二氧化碳，$/lb）、PM10（悬浮微粒，$/lb）、NO2（二氧化氮，$/lb）、SO2（二氧

化硫，$/lb）、VOC（有机挥发物，$/lb）、Stormwater interception（雨水拦截量，

$/gallon）、Median home resale value（每户转售价格中位数，$） 

 

普查规划（Inventory Planning） 

无论你是否已有现存普查或正在建立一个，普查规划的第一步将决定你需要什

么信息。针对普查，Streets 有些较弹性的选项和固定的规则。在本节中，我们

会说明可用于普查的项目字段，以及各字段的自定义义与预设类别。若你打算

建立新的普查，此节将帮助你规划资料收集。若你使用现有普查，此节会说明

你必需用于组织数据的架构。 

 

为了执行 Streets 分析，你的普查必需包含每棵树的种类及胸高直径。其它普查

信息皆非必要。收集越多每棵树的资料，分析效果越好，包括报告状况与维护

需求的能力、更换价值、地点、物种信息和病虫害侦测。此外，普查明细（行

道地址、GPS 坐标和测量日期）也可以收集以帮助管理记录。根据以下清单，

决定你将采用哪些测量项目。 

 

报告资料（Reportable data） 

Species（物种）：必需。Streets 使用代号辨识物种，而非学名或俗名。为

了大幅减少使用 Streets 所需的时间及精力，你应从一开始就使用 Streets

的物种代号辨识你的树木。完整的学名及俗名对应的代号清单可在此网

站（www. itreetools.org）的 Resources > Archives > i-Tree Streets & 
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STRATUM Species Codes by Climate Region 找到。Streets 会辨识每个区域

内最普遍的物种。然而，许多其它物种可能会包含在你的都市行道树普

查中。以不与清单重复的新代号命名这些物种后，你能直接将之输入

Streets。非树木代号也可用于追踪种植地点及树木残干等。 

 

胸高直径（DBH）：必需。使用直径范围或是实际值。 

 

树木 ID（Tree ID）：必需。每棵树都有一个独特的识别号码。Streets 会

自动产生这些识别号码。 

 

管理区域（Management zone）：非必需。你可选择将你的都市划分为管

理区域或各街坊区域，以提供更多各区都市林结构及效益差异的数据。 

 

行地道段（Street Segment）：样本普查数据必需。这是一个独特的编

号，辨识普查中的树木位于哪个行地道段。如果你使用〈附录一〉的方

法建立普查，此字段为 Tiger Line ID。 

 

都市管理（公共与私人）（City managed (public vs private)）：非必需。

如果你选择分开普查数据中的公共与私人树木，Streets 会将公共与私人

树木的效益及成本分开计算。 

 

状况（Condition）：非必需。状况类别为树的健康及结构等（例如，状

况不佳/好/死亡/垂死）。评估树木的状况将帮助规划未来管理需求，也可

确认不同地区的树况趋势。 

 

维护（Maintenance）：非必需。维护分为两个类别项目：建议维护

（Recommended Maintenance，如对小型树的例行维护及对大型树的立即

维护）与优先工作（Priority Task，如清理树冠和防治病虫害）。确定树

木的维护需求有助于未来树木管理工作，安排维护的顺序、种植及预算

编排。 

 

土地利用（Land use）：非必需。土地利用分类描述种植树木的大面积土

地利用状况（如住宅区、商业区及工业区）。评估土地利用有助于了解树

冠的分布及确认未来种植需注重之不足区域。 

 

现场种类（Site type）：非必需。现场种类确认种植的地点类别（如条状

及图案花样种植）。确定现场种类有助于比较树木的冲突、建议维护、了

解特定物种的种植地点问题。 

 

冲突（Conflicts）：非必需。冲突类别包括两个项目：人行道损坏及电线
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冲突。人行道损坏项目测量附近树木对人行道的破坏（如人行道隆起

3/4-1 1/2 英寸）。电线冲突为树枝与高架公共设施管线的潜在或现行冲

突。评估这些冲突状况可预测人行道维修或树木修剪等的维护成本，并

辨识造成最多冲突的品种。 

 

病虫害的征兆与症状（Pest signs and symptoms）：非必需。病虫害检测

项目使用制式及系统性流程，由美国林务局开发，用以评估病兆及病征

以帮助早期发现病虫害与病害。该程序要求每棵树完成约 15个数据项，

包含检查树干、树枝及树叶之压迫、损坏或不正常生长等征兆。因为程

序的关系，这些项目无法在 Streets 中自定义义。有关更详细的信息，请

参阅病虫害检测程序网站（www.itreetools.org/ iped/index.php）或在线维

基 IPED 资源网（http://wiki.bugwood.org/IPED）。 

 

其它（Other 1, 2, 3）：非必需。Streets 最多允许收集 3个附加数据项。

请注意，此数据为非开放的项目，但必需分为 10个或更少种类。例如，

一个名为「总论」的项目无法被建立，但名为「地标树」且具有「是」

与「否」类别的项目就可以自由建立。 

 

普查数据细节（Inventory details） 

位置和测量者的信息以及说明或备注皆可纳入 Streets 的记录。尽管此信息不会

显示在报告中，你可以在记录时查看此讯息并用它分类数据、找到并再次编制

每棵树木，或在 Streets 外分析。 

行道地址（Street address）：记录门牌号码及行道名称。 

GPS 之纬度及经度（GPS latitude/longitude）：记录树木的 GPS 坐标位

置。 

测量者（Surveyor）：记录测量树木数据的人员或小队。 

测量日期（Survey date）：记录测量日期。 

地点（Location site）：记录种植地点相关的建筑物地址（如前、后、左

及右侧）。 

地点代号（Location number）：记录树的位置以区分同地址的众多树木

（如顺着车流方向以连续号码命名树木）。 

 

定义每个项目类别（Defining categories for each field） 

以上说明的普查项目在 Streets 内皆有默认类别选项。除了病虫害检测项目之外

的所有默认项目皆可自定义义以符合你的需求。以下的工作表列出每个默认项

目，空格可填入你决定收集的自定义义项目。 

  

http://www.itreetools.org/
http://wiki.bugwood.org/IPED
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定义胸高直径类别工作表（Define DBH Categories worksheet） 

如果你决定以等级测量胸高直径而非确切数值，你需输入每个等级对应之数值

范围。 
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定义管理区域工作表（Define Management Zones worksheet） 

如果你将都市划分成各管理区域或街坊地区，输入它们的名称（如果需要的

话），如果有更多区域，使用额外的工作表。 
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定义状况工作表（Define Conditions worksheet） 

如果你打算收集关于树木状况的普查数据并更改默认选项，你必需在此定义代

号。替代因子百分比（Replacement factor percent，RFP）使用 CTLA 方法计算

树木的替代值，反映特定条件下典型树木的相对结构完整性及健康。以下提供

适当的 RFP 以符合你的状况。 

 

 

Dead or dying（死亡或垂死）、Poor（虚弱）、Fair（尚可）、Good（好）。 
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定义维护工作表（Define Maintenance worksheet） 

如果你决定收集与树木维护建议或优先工作相关的的数据并更改默认选项，你

必需在下方定义代号。 

 

 
None（无），Small tree (routine)（一般小型树），Small tree (immediate)（紧急的小型

树），Large tree (routine)（一般大型树），Large tree (immediate)（紧急的大型树），

Critical concern (public safety)（重要议题，公共安全）。 
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Stake/train（树桩/下摆物），Crown clearing（树冠清洁），Crown raising（树冠生长提

高），Crown reduction/thinning（树冠减少/疏伐），Remove（清除），Treat pests/disease

（病虫害/疾病处理情形）。 
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定义土地利用工作表（Define Land Use worksheet） 

如果你决定收集与土地利用相关的信息并更改默认选项，你必需在下方定义代

号。 

 

 

Single family residential（单户住宅），Multi-family residential（多户住宅），Small 

commercial（小型商业用地），Industrial/large commercial（工业用地/大型商业用地），

Park/vacant/other（公园/未利用土地/其它） 
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定义现场类别（Define Site Type worksheet） 

如果你决定收集与现场类别相关的信息并更改默认选项，你必需在下方定义代

号。 

 

 

Front yard（前院），Planting strip（条状种植），Cutout（图案花样种植），Median（中

央），Other maintained locations（其它维护地点），Other unmaintained locations（其它未

维护地点），Backyard（后院）。 
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定义冲突工作表（Define Conflicts worksheet） 

如果你决定收集与人行道损坏和公共管线冲突相关的信息并更改默认选项，你

必需在下方定义代号。 

 

 

（单位英寸） 

 

 

No lines（无管线），Present and no potential conflict（有管线但是没有潜在冲突），

Present and conflicting（有管线且有冲突）。 
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定义其它一工作表（Define Other 1 worksheet） 

如果你决定自定义义其它一的类别，你必需在下方定义代号。 

 

 

Title of category（类别标题）。 

 

  



27 

 

定义其它二工作表（Define Other 2 worksheet） 

如果你决定自定义义其它二的类别，你必需在下方定义代号。 

 

 

Title of category（类别标题）。 
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定义其它三工作表（Define Other 3 worksheet） 

如果你决定自定义义其它三的类别，你必需在下方定义代号。 

 

 

Title of category（类别标题）。 
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建立抽样样本（Creating a Sample） 

如果你没有现存普查数据，且已决定建立一个非完整的样本普查数据，下一个

步骤是设计一个街道区段随机抽样。这能以多种方式完成，其中之一会在〈附

录一〉说明。很重要的是，任何随机抽样方法皆需遵循线性街段，以与 Streets

模型兼容。 

 

一般而言，样本普查数据涵盖全体街道区段样本的 3-6%，根据小区大小及街道

差异而有所不同。此抽样会产生 10%的全市树木个数标准偏差。下方的一般准

则可作为决定抽样样本大小的基准： 

 

 小区人口数 50000以下时，样本大小为全体街道英哩或区段的 6%。 

 小区人口数 50000-150000 时，样本大小为 5%。 

 小区人口数 150000-250000 时，样本大小为 4%。 

 小区人口数 250000以上时，样本大小为 3%。 

 

所有小区的树木密度、行道长度及人口等特征均不同，因此没有统一的抽样密

度。最后，你仍需根据结果的使用方向，决定样本大小及可接受的标准偏差范

围。 

 

无论你使用哪种抽样方法建立你的样本，最后结果应是街道区段的简单随机抽

样。此外，你必需知道你研究区域内的总街道区段数量。如果你将研究区域划

分为管理区或是街坊区，你必需知道各区域的总街道区段数量。在下方工作表

上，输入各区域或都市的总街道区段数量。 

 

注意：为样本普查数据收集数据时，有几件事情必需注意。〈第三阶段〉将针对

这点讨论。 
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抽样样本工作表（Sample worksheet） 

如果你已将都市划分为管理区或街坊区，且正在建立一个样本普查数据，填写

各区域的总区段数量（不是抽样数量）。如需要更多区域，使用额外的工作表。

如果你没有使用管理区，在下方的区域 1（Zone 1）输入全小区的街道数量。 
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建立街区清单（Creating a List of Streets） 

如果你决定建立一个完整普查数据，并拥有计划区域内的全部街道列表，这将

简化数据的收集。在 Excel 建立的 .csv 档文件中的每一排填写一个街道名称，

或在Word、Notepad、Wordpad建立的 .txt 档文件中的每一行填写一个街道名

称。 

 

格式化现有普查数据（Formatting Existing Inventories） 

如果你正在使用现有普查数据，你必需格式化你的数据以符合 Streets 的要求。

最后结果需为一个 Microsoft Access 数据库，至少包含物种及胸高直径项目，但

可额外包含表一（Table 1）的 28个项目或病虫害调查表中的所有项目（见〈附

录三〉）。该 Access 文件可任意命名，但数据库内的表格需命名为

STRATUM_Inventory。 

 

格式要求如下： 

1) 你需包含你拥有数据的项目字段。例如，如果你只有物种及胸高直径的

数据，你的数据库只需包含这两栏。 

2) 项目名称一定要符合表一（Table 1）所示，检查拼字错误。 

3) 你的数据一定要符合表一（Table 1）的格式。例如，物种代号

（SpCode）项目需为文字格式（text），胸高直径项目则为数字

（number）格式。 

4) 没有数据的字段应留以空白或填写 0。在输入 Streets 的过程中，可以省

略未在普查数据使用的数据项。 

 

补充指南书《Formatting Existing Inventories into Streets》，可在此网站

（www.itreetools.org）的 Resources > Archives 中找到，汇入现有普查数据到

Streets 的范例和其它信息也可在该处找到。 

 

现有的 STRATUM or MCTI 档案（Existing STRATUM or MCTI projects） 

如果你拥有较旧的 STRATUM 格式数据库（STRATUM-formatted 

database，.mdb 格式）或大型 i-Tree数据库（i-Tree Grand Database，.mdb 格

式），这些皆不需重新格式化；他们可以现有形式汇入。事实上，如果你拥有较

旧的 STRATUM 项目（扩展名为 .proj），此档案本身可直接从 Streets 档案选单

开启。 

 

现有的 MCTI档案（Existing MCTI projects） 

如果你有现存的 MCTI档案并选择汇入此数据到 Streets 内，此 MCTI.mdb 数据

库需照上述所示重新格式化以符合 Streets 要求。完成后即可汇入现有数据。我

们建议你使用副本，而非原始的MCTI数据库。 



32 

 

表一（Table 1）为 Streets Access 数据库所需的项目名称、格式及类别选项。仅

需包含你拥有的数据所对应的项目。记住，格外注意项目名称的拼音，名称必

需完全正确。项目名称的说明在第 13 至 15页。 
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第二阶段：开始执行 Streets（Phase II: Getting 

Started with Streets） 

开始收集资料后，你需决定欲收集哪些项目、如何自定义义每个项目的类别，

以及建立随机抽样。准备好后，是时候开始执行软件了。 

 

1) 欲开始执行 Streets，请先点击你计算机的开始选单 > 所有应用程序 > i-

Tree > 

Streets。 

2) 欲建立新项目，请点击 File > Open > New project。新项目的窗口将开

启。 

a. 新建立的项目窗口将要求你命名及选取该项目数据库储存的路

径。在 Database字段旁，点击 Specify 按钮并选择 Create 

New。浏览至该档案的储存路径。于 File Name 输入文件名并

点击 Save。 

 

请注意：Specify > Select Existing 选项允许你增加一个新项目

到一个现有的 Streets 项目数据库。 

b. 在 Project Name中输入名称。 

c. 在 Inventory Type的下拉式选单中选择完整或样本普查数据。 

d. 在 Year中输入数据库建立的年份。 

e. 在 Climate Region 的下拉式选单中，选择你所在都市的气候区

域。如果你不确定该选择哪个气候区，点击 View Map（如图

1）。 

f. 点击 Finish 以移动到下个窗口。 

3) 在 Define City 窗口的下拉式选单中，选择你的国家、州、县郡及都市。 

a. 如果你使用定义都市工作表（Define City Worksheet）收集你都

市的资料，你可以现在输入数据，或之后藉由点击 Input > 

City Information 返回此窗口。点击 OK以移动到下个窗口。 

4) 在 Define Cost 窗口中，输入你使用定义成本工作表（Define Costs 

worksheet）收集之公共及私人树木的预算信息。你也可以在之后点击

Input > Annual Costs，返回此窗口添加或编辑数据。点击 OK以移动到

下个窗口。 
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图 1（Fig.1）Streets 气候区域 
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5) 在 Benefit Prices 窗口中，输入你使用定义效益价格工作表（Define 

Benefit Prices worksheet）收集的效益价值，或点击 OK接受区域默认选

项。你也可以在之后点击 Input > Benefit Prices，返回此窗口添加或编

辑数据。点击 OK以移动到下个窗口。 

6) 接着，User Defined Fields 选单将开启。在 Record 标签页中，勾选你决

定收集或已存在于现有普查数据的字段之框框。如果你将使用 PDA作业

或计划手动输入数据，请记住，只有在此勾选的项目可以使用。你可以

点击 Input > Data Fields 返回此窗口与任何后续窗口，以添加或编辑数

据。 

a. 点击 DBH 卷标页，选择你将依等级或精确值测量。选择测量

单位为英寸或公分。如果你选择建立自己的胸高直径测量等

级，依照你的定义胸高直径类别工作表（Define DBH 

Categories worksheet），在左侧输入适当的范围。点击 Defaults

以还原 Streets 的默认选项。 

b. Zone/Sample 卷标页有两个功能：将普查数据分层为区域，并

替各区域或都市内的街道标示代号。如果你在〈第一阶段：开

始进行：普查数据规划〉中，决定将你的都市分成管理区与街

坊区，且在定义管理区域工作表（Define Management Zones 

worksheet）中为它们命名，你应于此里输入区域名称。如需新

增区域，点击 New 并直接在该字段输入此区域的名称。 

 

若为样本普查，直接在 Number of Segments 下的字段输入样

本工作表（Sample worksheet）的各区段总数量。如果你尚未

于普查数据划分区域，在 Zone 1 输入全市的街道总数量。 

 

﹝请注意：这是可用的总数量，不是抽样的总数量。抽样总数

会自动在普查记录。﹞ 

7) 如果你已建立街道清单以在普查中使用，请点击 Streets 标签页，再点击

Import List，导航到储存位置。点击 Open。或者，你也可以直接在字段

中输入街道名称；ID 代号将自动产生。 

8) 在剩余的字段中，输入工作表内的各自定义义类别或使用默认选项。点

击 Defaults 还原所有类别为 Streets 默认选项。 

9) 编辑完普查数据字段后，请点击 OK。你可以点击 Input选单 > Data 

Fields 返回 User Defined Fields 窗口以随时变更普查数据字段。 

 

完成后，你的项目将自动储存。若未来欲变更数据，你需确保自己经常储存作

业，路径为 File > Save Project，或点击磁盘片图标（disk icon），或按 Ctrl + 

S。 
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请注意：如果你已决定在纸上建立普查数据，或使用 PDA与行动装置之外的设

备，你可以前往实地调查。 

 

准备使用智能型手机及平板计算机收集数据（Preparing for Data 

Collection with Smartphones and Tablets） 

为你的普查数据定义完成项目字段及类别后，这些数据可传送至网络上，帮助

你使用行动装置收集数据。 

 

请注意：如果你将使用病虫害检测程序，在开始 PDA配置前，请确定更新。这

将确保你可以装载来自美国林务局森林健康专家的最新信息。请选择选单中

Help 选项下的 Update IPED以进行更新。 

 

传送项目配置到网络（i-Tree的在线服务器）（Send project configuration to the 

Web (i-Tree online server）） 

为了传送你的自定义义数据项及其它项目信息至网络上，以供你在行动装置存

取： 

1) 点击 Tool 选单 > Work with Mobile。Streets 的Mobile Manager 窗口将

开启。 

2) 点击 Submit Project Configuration 后，点击 Next。 

3) 如果这是一个新项目，下一个窗口将为空白。 

 

请注意：若为现有项目，在此窗口中，你需选择你任一棵树木，该树木的数据

将可于实地使用。这将有助于你的质量管理检验。 

 

4) 点击 Next。 

5) 在最后的窗口中，你会被要求输入电子邮件地址与密码。（注意，这些与

你的 i-Tree登入凭证无关。）在你的作业期间，该电子邮件与密码都与此

项目相关，因此务必将它们记下来。该项目专属的连结将被寄送至你所

输入的电子邮件地址。此链接在项目作业期间皆有效，且应与所有数据

收集者共享，以透过网络存取该项目的在线数据收集表格。 

Project email address: _______________________________ 

Project password: ___________________________________ 

 

请注意：为了最有效地管理项目，每一项项目应有一位数据管理者，使用一台

计算机执行 Streets 项目。此人将负责下载所有提交至服务器的数据，并适当地

将数据汇入 Streets 中。 
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准备使用 PDA收集数据（Preparing for Data Collection with 

PDA） 

为你的普查数据定义完成项目字段及类别后，如果 PDA是你选择的普查数据收

集方法，这些数据可传送至 PDA上。 

 

请注意：如果你将使用病虫害检测程序，在开始 PDA配置前，请确定更新。这

将确保你可以装载来自美国林务局森林健康专家的最新信息。请选择选单中

Help 选项下的 Update IPED以进行更新。 

 

检查状况及安装必要组件（Check status and install necessary components） 

准备传送数据到 PDA时： 

1) 请将其连接到你的计算机。你的计算机必须能辨识你的 PDA。 

 

﹝注：若你的计算机无法辨识你的 PDA，请查看 PDA的说明书。﹞ 

2) 在计算机开启 Streets 程序，选择 Tool 选单 > Work with PDA。Streets 

PDA Transfer 窗口将开启。 

3) 点击 Check Status。Streets 将检查你的计算机是否安装 ActiveSync或

Windows Mobile Device Center、是否有适用的 PDA操作系统与适当

的.NET 版本，以及是否安装 Streets PDA应用程序。如果没有，不适当

的版本或缺少的软将显示为红色，且安装按钮将亮起。 

4) 点击 Install 以开始安装必要软件。点击 Yes 以安装 i-Tree Streets PDA 应

用程序，按照桌机与 PDA屏幕上的指示进行。安装完毕后，点击 Check 

Status 以确定所有安装皆成功。如果有任何版本仍显示红色，再点击

Install，并重复步骤。 

 

传送项目配置到 PDA （Send project configuration to PDA） 

为传送你的自定义义数据项字段及其它项目信息到 PDA： 

1) 在桌面上点击 Tool > Work with PDA。 

2) PDA与你的计算机联机并开始通讯后，点击 Send Project Configuration 

to the PDA。 

 

你只能经由桌机应用程序变更 PDA的配置（例如，加入新的项目字段、编辑类

别定义等）。如需变更： 

1) 从 Streets 的桌机接口，点击 Input 选单 > Data Fields 以进行变更。 

2) 按照上述步骤传送项目配置到 PDA。这会覆盖你先前的配置选择。 

 

请注意：为了最有效地管理项目，每一项项目应有一位数据管理者，使用一台

计算机执行 Streets 项目。此人将负责下载所有提交至服务器的数据，并适当地

将数据汇入 Streets 中。 
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第三阶段：实地调查（Phase III: Out in the Field） 

 

样本普查数据（Sample Inventories） 

建立不同于完整普查的样本普查数据时，有几点事项需注意。首先，你仅能收

集清单上所列区段之树木的资料。第二，若某个区段没有树木，请务必记录此

信息，以估算该城市的树木总数。 

 

若为无树木区域，请于普查创建记录并输入以下数据： 

 树木编号：即使该树并不存在，给予一个编号。 

 管理区：若配置项目的过程中你决定追踪管理区域，记录该区段所属

之区域。 

 街道区段：记录街道区段。 

 物种：输入该状况特定之编码，如「NOTREE」。 

 

由于该树并不存在，其它数据没有必要记录。 

 

请注意：若你在可种植空间及具有可种植空间的无树木区段采集数据，

「NOTREE」的记录就不需创建。 

 

若你使用纸制表格或非 i-Tree平台建立样本普查数据，你可以直接前往该区域

收集数据。若你使用 PDA或行动装置，指示如下。 

 

使用智能手机或平板计算机（Using Your Smartphone or Tablet） 

以行动装置使用 Streets 的几点注意事项（Some important things to know about 

using a mobile device with Streets） 

欲允许最多装置存取 Streets，我们选择以网络窗体形式建立行动装置的功能，

让你使用装置的网页浏览器取用，而非以 app形式开启。这造成使用上的几个

结果： 

 当你收集数据时，其将暂时储存于你网络浏览器的缓存中。可用的储存

空间会根据装置、浏览器及设定而有明显差异。你可以藉由清除浏览器

的历史记录与数据以增加储存空间。如果你的浏览器历史记录或其它数

据用尽储存空间，你的样区数据可能会受限成相对较少的记录。若是清

除历史记录及数据，你或许能储存数百笔记录。无论如何，数据应经常

上传至服务器（见下文）！ 

 对于 Chrome、Firefox 及 Safari 的使用者而言，虽然你将透过网页进行作

业，但你不被限制于在有网络（无线网络、3G、4G，或 Edge网络）时

才能进行作业。上述的网络浏览器缓存将允许你在没有网络联机时暂时

作业。即便你不需担心短期的网络断线，但最后你仍需联机并提交你的



39 

 

数据。 

 遗憾的是，这并不适用于 Internet Explorer 的使用者。IE的脱机缓存能力

有限，用户在收集实地数据时需保持联机。因此，如果你使用 IE，你应

随时准备好将数据从行动装置上传至服务器中，并了解若是失去数据连

接，你最后一次提交的所有数据将会遗失。 

 当你的缓存记忆越来越满，你将收到一条警告讯息建议你清除浏览器的

缓存及历史记录。你必须在执行该动作前上传你的数据，否则数据将会

遗失！ 

 

开始执行（Getting started） 

请记住，Streets 的数据收集功能不是一个 app，是一个网络存取的网络表格，

为你的项目专门设计的。欲存取此网络表格与开始收集数据： 

1) 开启你的智能手机或平板计算机的电子邮件应用程序。 

2) 开启含有你项目的专属网络表格链接的电子邮件。 

3) 一个新窗口将在你装置的网页浏览器中开启。开始前，在测量者框框

（Surveyor box）中输入使用者名称，并点击 Login。 

 

选项选单（Options menu） 

左上方的 gear wheel 允许你开启 Options 选单，选单内有更进阶的操作，例如

上传数据、重新加载项目配置，以及调整每一页可检视的项目数量。 

 

树/页数目（Number of trees/page）：开始收集数据或重新检视现有的资

料时，树木的数量将使滚动检视变得困难。欲改变每页显示的树木数

量，调整滑条以设置树木数量；欲在一个页面上查看所有树木，将数值

设置为 0。 

 

重载专案（Reload project）：有时，项目管理者可能会表示有些项目配

置细节已变更，因此需重新加载项目以整合变更。在你上传任何新数据

后，请点击 Reload Project 按钮以完成更新。 

 

上传资料（Submit data）：经常上传数据到网络服务器十分重要！在上

传数据（Submit data）窗口内，于该页上方确认欲上传的样区数量后，

点击 Submit button。 

 

新增树木（Adding trees） 

欲新增树木到普查时，点击主页右上角的加号。你将透过几个页面进行工作，

其将在以下详细描述。在页面上完成数据输入后，点击页面上的右箭头以前往

下个步骤。 
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位置（Location） 

ID：自动生成的编码，以避免重复。 

 

区域（Zone）：若决定将你的城市划分为管理区或住宅区，从下拉式选

单选择管理区。 

 

街段（Street Segment）：若为样本普查，在此输入街段 ID。若使用〈附

录一〉的随机抽样方法，此为 Tiger Line ID。 

 

街道名称（Street Name）：若在设定过程中上传街道清单，从下拉式选

单中选择街道，也可透过点击字段右侧的加号，手动输入街道名称。 

 

街道号码（Street Number）：输入门牌号码或邮政编码。 

 

位置编号（Location Number）：若在同一地址或位置有多于一棵以上的

树木，在此输入数字区分它们。 

 

位置所在地（Location Site）：相对于建筑物地址的种植位置可于此记

录，例如前、后、右侧、左侧或用户自定义的选项。 

 

土地用途（Land Use）：从下拉式选单中选择最合适的土地利用类型。 

 

地点类型（Site Type）：从下拉式选单中选择最合适的地点类型。 

 

都市管理（City Managed）：该树由都市管理，勾选此选框，并取消勾选

私人行道树的勾选框。 

 

保留位置（Hold Location）：勾选此选框可以保留地址讯息，供该树与其

余树木使用。因此，若为树木数量较多的区域，可以不用重复输入地址

信息。 

 

清除位置（Clear Location）：收集完同一地址的所有树木，并准备前往

下一个地点时，可以使用清除位置按钮以删除所有位置数据，重新开

始。 

 

定位系统（GPS） 

开始（Start）：点击 Start以开始卫星定位。粗略的经纬度与估算精确度

将显示。可能需要长达数分钟的时间以取得足够数量的卫星达到可接受

的准确度。 
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取得（Capture）：数据精确度达到可接受的水平时，点击 Capture以保

存这些数值。 

 

坐标也可手动输入。 

 

﹝注：GPS 的精确度取决于设备、讯号与环境因素。欲了解更多信息，

请咨询设备制造商。﹞ 

 

物种（Species） 

物种（Species）：使用下拉式选单选择树种。点击下方的按钮以切换学名

和俗名列表。 

 

若找到一个不在列表中的物种，点击域名旁的加号，Add Species 窗口将

开启。为避免物种重复，你将被要求在此处输入物种的 4个字母代码。

（这些物种编码是 Streets 众多功能的基础，但通常不会向具网络功能之

行动装置的用户显示。） 

 

建立物种代码最简单的方式，是组合属名及种名的前两个字母。例如，

Juglans nigra（黑核桃）就是 JUNI。若收到错误讯息，表示物种代码已

被使用，你可以在代码后追加一个数字结尾，例如 JUNI_2。该物种代码

将出现在学名和俗名清单中。（项目管理者可在 Streets 桌机版本输入正

确的学名和俗名。新配置启用后，行动装置将显示名称而非代码。） 

 

DBH：欲准确测量 DBH，直接输入 DBH之测量值。欲以分级法记录

DBH，从下拉式选单选择对应的 DBH分级类别。 

 

木材/叶片情况（Condition of Wood/Leaves）：从下拉式选单中选择情况

描述。 

 

注释/批注（Note/comment）：在此栏加注说明。 

 

加注此树（Note this tree）：若某树状况特殊，勾选此选择框。例如不确

定此树品种，或项目管理者认定的其它原因。 

 

管理（Management） 

维护建议（Maintenance Recommendation）：从下拉式选单选择最重要

的维护建议。 

 

优先工作（Priority Task）：从下拉式选单选择优先工作。 
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人行道损坏（Sidewalk Damage）：从下拉式选单选择人行道的损坏程

度。 

 

电线冲突（Wire Conflict）：从下拉式选单选择适当的电线冲突。 

 

其它（Other 1, 2, 3）：从下拉式选单选择相应的选项。 

 

病虫害（Pest）： 

初始的病虫害检测窗口将要求你评估树木整体、树叶/树枝和分支/主干是否有病

虫害迹象。若你针对任一项目回答「yes」，将开启另一个窗口，询问你进一步

地定义损害。回答完所有问题后，病虫害窗口最后将要求你辨识该虫害。若无

法确定，选择 Unknown。 

 

有关详细的现场数据收集程序，请参阅 Inventory Pest Early Detection（IPED）

手册，在此网站（www.itreetools.org）上的 Resources > Manual and 

Workbooks，或 IPED 维基在线资源网（wiki.bugwood.org/IPED）。 

 

请注意：记住，数据不会自动上传到服务器！欲将数据储存至服务器，你必需

如上所述提交数据。点击主页左上角的齿轮存取已提交的资料。请经常上传数

据！ 

 

你已准备好前往下一棵树了。 

 

使用 PDA（Using the PDA） 

欲进入 PDA应用程序，从 PDA应用程序选单（Programs menu）选择 i-Tree 

Streets。 

 

概述（Overview） 

若你在项目配置阶段决定如此，点击 Log In按钮以输入调查日期与调查人/调

查团队。点击 Add New Tree开启五个标签页面：Location、GPS、Species、

Mgt与 Pest。这些选项的细节将在稍后详细说明。Edit Tree 按钮连接已编制的

树木清单，你可以选择任一树木以编辑相对应的字段内容，字段内容同 Add 

New Tree选项所示。Clear ALL Data 可完全删除已编制的树木。Backup Data 

to SD Card 提供资料额外的保护，若你的 PDA具此功能，你可以将数据储存至

一张 SD卡上（高度建议）。Settings 按钮展示你于桌机配置 PDA阶段时选择的

选项概观，若你的装置具有 GPS 功能，且你决定在项目建立时收集 GPS 信

息，你可以于此配置 GPS 系统。 

 

GPS 配置（Configuring GPS） 
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若你的 PDA具 GPS 功能且欲收集 GPS 数据，从 PDA主选单点击 Settings 以配

置 GPS。点击 Scan Ports 以移植 COM Port、Baud Rate、Parity、数据和 Stop 

Bits 字段。扫描完成后，点击 Test GPS。若不成功，请参阅 PDA使用者手册以

调整设置。 

 

添加新树（Add New Tree） 

Add New Tree 功能是 PDA应用程序的核心。点击主页面上的 Add New Tree按

钮，开启五个已卷标功能名称的窗口：Location（位置）、GPS、Species（物

种）、Mgt（管理）和 Pest（病虫害）。在每个窗口中，你只能输入 PDA桌机配

置时所选择的信息。不需要的字段将呈现灰色或标记为不必要（Not 

Required）。 

 

位置（Location） 

树木 ID（Tree ID）：自动生成的编码，以避免重复。 

 

街段（Street Seg）：若为样本普查，在此输入街段 ID。若使用〈附录

一〉的随机抽样方法，此为 Tiger Line ID。 

 

地址号码（Address #）：输入门牌号码或邮政编码。 

 

区域（Zone）：若决定将你的城市划分为管理区或住宅区，从下拉式选

单选择管理区。 

 

街道（Street）：若在设定过程中上传街道清单，从下拉式选单中选择街

道，也可透过点击字段右侧的加号，手动输入街道名称。 

 

位置所在地（Location Site）：相对于建筑物地址的种植位置可于此记

录，例如前、后、右侧、左侧或用户自定义的选项。 

 

都市管理（City Managed）：该树由都市管理，勾选此选框，并取消勾选

私人行道树的勾选框。 

 

位置编号（Location No.）：若在同一地址或位置有多于一棵以上的树

木，在此输入数字区分它们。 

 

土地用途（Land Use）：从下拉式选单中选择最合适的土地利用类型。 

 

地点类型（Site Type）：从下拉式选单中选择最合适的地点类型。 
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保留位置（Hold）：勾选此选框可以保留地址讯息，供该树与其余树木使

用。因此，若为树木数量较多的区域，可以不用重复输入地址信息。 

 

卫星定位（GPS） 

开始（Start）：点击开始以开始配对卫星；这可能需要几分钟的时间，

也可保持开启状态，以避免每棵树皆需重新配对（请注意，此动作十分

耗电）。 

 

捕捉（Capture）：捕捉功能开启后，将连续捕捉经度和纬度；理想状况

下，获取资料前需已追踪三个或更多卫星。 

 

接受（Accept）：当坐标捕捉记录稳定后，点击接受以记录经纬度坐标到

普查中。 

 

停止（Stop）：点击停止按钮，可停止收集卫星数据；在记录树木之间的

空档使用该功能，可节省电池用量。 

 

直接输入（Direct entry）：选择此选项以手动输入坐标。 

 

﹝注：GPS 的精确度取决于设备和环境因素，如欲了解更多信息，可咨

询设备制造商。﹞ 

 

物种（Species） 

物种（Species）：使用下拉式选单选择树种。点击下方的蓝色按钮，切换

学名和俗名清单。若树木不符合列表内的选项，可直接输入新物种代

码。手动输入的代码需回到桌机进行物种匹配工作。这将会在〈第四阶

段〉进一步说明。物种代码的完整列表，请参阅此网站

（www.itreetools.org）Resources > Archives下 Climate Region 的《i-Tree 

Streets & STRATUM Species Codes》。 

 

DBH：欲准确测量 DBH，直接输入 DBH之测量值。欲以分级法记录

DBH，从下拉式选单选择对应的 DBH分级类别。 

 

木材/叶片情况（Condition of Wood/Leaves）：从下拉式选单中选择情况

描述。 

 

注释/批注（Note/comment）：在此栏加注说明。 

 

加注此树（Note this tree）：若某树状况特殊，勾选此选择框。例如不确

定此树品种，或项目管理者认定的其它原因。 
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管理（Mgt，Management） 

维护建议（Maintenance Recommendation）：从下拉式选单选择最重要

的维护建议。 

 

优先工作（Priority Task）：从下拉式选单选择优先工作。 

 

人行道损坏（Sidewalk Damage）：从下拉式选单选择人行道的损坏程

度。 

 

电线冲突（Wire Conflict）：从下拉式选单选择适当的电线冲突。 

 

其它（Other 1, 2, 3）：从下拉式选单选择相应的选项。 

 

病虫害（Pest） 

初始的病虫害检测窗口将要求你评估树木整体、树叶/树枝和分支/主干是否有病

虫害迹象。若你针对任一项目回答「yes」，将开启另一个窗口，询问你进一步

地定义损害。 

 

回答完所有问题后，病虫害窗口最后将要求你辨识该虫害。若无法确定，选择

Unknown。若没有压力症状或病虫害征兆，则选择 None。 

 

有关详细的现场数据收集程序，请参阅 Inventory Pest Early Detection（IPED）

手册，在此网站（www.itreetools.org）上的 Resources > Manual and 

Workbooks，或 IPED 维基在线资源网（wiki.bugwood.org/IPED）。 

 

存档（Save） 

树木的所有数据输入完毕后，点击 Save储存档案到普查中。若存档后需要更

改，返回主页面再点击 Edit Tree。选择欲编辑的树，点击 Edit。使用上述窗口

更改数据，再点击 Save。 

 

请注意：若选择了病虫害检测项目，储存树木记录前，需在每棵树的主要病虫

害字段输入数据。 

 

你已准备好前往下一棵树了。 
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第四阶段：回到办公桌：执行 Streets（Phase IV: 

Back at Your Desk: Running Streets） 

 

将数据传送到 Streets（Transferring Data to Streets） 

使用智能型手机或平板计算机建立的新普查数据（New inventories conducted 

with a smartphone or tablet） 

欲存取行动装置上的数据，在计算机桌面开启 Streets 应用程序。从 Tools 选单

选择Work with Mobile，再选择 Retrieve Project Data，输入之前你所设定的密

码。 

 

接着，树木列表将开启。选择欲取用的树木后，点击 Finish。 

 

使用 PDA应用程序建立的新普查数据（New inventories conducted with the PDA 

application） 

欲传送 PDA收集的普查数据数据到计算机桌机，需将 PDA与计算机联机。在

计算机桌机上的 Streets 应用程序中，从 Tools选单选择Work with PDA。在传

输实地数据（Field Data Transfer）区块，点击 Retrieve Data from PDA。点击

OK以关闭窗口。你的普查数据已传送至 Streets，PDA数据也已被清除。 

 

PDA的 Clean PDA of Collected Data 功能也能删除 PDA条目。 

 

手动输入数据（Manual data entry） 

使用 Streets 在 Input > Records 的数据输入窗体可手动输入数据。点击 New 添

加新条目，类似于 PDA内建的窗体将开启。在各卷标页（一般项目 General、

地点 Location、树木信息 Tree Info、管理Management、其它 Other、虫害

Pest）完成数据输入。请记住，只有你在配置阶段选择的项目字段可供使用。 

 

汇入 Access 数据库普查数据（Importing Access database inventories）： 

如果你有一个现存普查数据，或你使用 PDA以外的电子格式建立普查数据，使

用 File选单中的 Import > Inventory Data 将之汇入 Streets。欲汇入的普查数据需

依照 Streets 的要求格式化并存盘为一个 Microsoft Access 数据库，而你的树木

普查数据需储存于表格中，该表格需命名为「STRATUM_Inventory」。 

 

注：请参考先前〈第一阶段：开始进行：格式化现有普查数据〉以获得更多信

息。 

 

现有的 STRATUM专案（Existing STRATUM projects） 

较早的 STRATUM 专案（檔名*.proj）可直接透过此路径 File > Open > Existing 
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Project开启。若你没有现存的 STRATUM 项目，但有依照 i-Tree版本 1.x 或

2.x 格式、储存在 STRATUM 格式的数据库（*.mdb）或大型 i-Tree 数据库（i-

Tree Grand Database，*.mdb），你可以透过此路径 File选单 > Import > 

Inventory Data 使用它。务必参考〈第一阶段：开始进行：普查数据规画〉的

指示定义项目参数。 

 

检查错误（Checking for errors） 

汇入普查数据后，检查以确定数据正确性是非常重要的。透过此路径 Input > 

Records 可找到普查数据列表。滚动列表逐项检查，红色惊叹号代表输入的代

码不正确或没有匹配的物种。欲更正错误，点击错误的条目开启手动数据输入

窗体，允许你更改数据。 

 

请注意：某些情况下，错误需在 Input > Data Fields 路径下更正，例如，若你

的普查数据在 Condition 下含有五个数据字段，却只有四个数据字段在启用状

态。 

 

项目结合（Combining projects） 

你可以透过 Streets 结合普查数据，例如，将城市分组以获得一个区域性都市林

概况，甚至构成国家的都市林概况。欲结合普查数据，建立一个新的项目，接

着透过 File选单> Import > Inventory Data 路径依序加入普查数据。记得使用

Tree普查（Tree Inventory）窗口的 Input > Records 检查有无代表错误的惊叹

号。 

 

请注意：普查结合功能要求普查数据有类似的结构，包含样本/完整普查数据、

气候区与数据字段。 

 

物种匹配（Species Matching） 

你的普查数据可能包含 Streets 预设列表没有的物种或物种编码。在这种情况

下，在上传数据后，你看到的第一个窗口是定义物种（Define Species）窗口。

（这窗口也可透过 Input > Species 路径开启。）无法匹配的物种代码将被标示红

色惊叹号。欲匹配各标记物种： 

1) 点击行内并输入相应的学名和俗名。 

2) 在第四栏，指定 SP.值（Assigned Sp. Value），你必需从下方列表选择最

相配的物种。点击空白的 Assigned Sp. Value框框反白。接着，在窗口最

底下的列表中，从下拉式选单选择最相关的俗名或学名。考虑成熟大

小、树木类型、外型与科属关系。若难以直接匹配，可从树木类型中选

择。（例如，落叶阔叶树木树叶大、常绿针叶树木树叶小。） 

3) 若你建立的样本普查包括无树街段，忽略这区段的任何物种编码（例
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如，NOTREE）。维持为无匹配即可。 

 

编辑预设物种（Editing default species） 

你应检视列表上物种的预设分配。例如，在你所在的地区，紫薇一般可能会被

认为是落叶阔叶小型乔木，但当地条件可能使落叶阔叶中型乔木为更符合的选

择。任何所列物种皆可改变物种数值，方式如下： 

1) 选择该行，并透过下拉式选单更改 Assigned Species Value。 

2) 你也可以使用物种定义窗口编辑默认的物种俗名，配合你所在的小区。

直接在字段内点击欲编辑的俗名，并输入以覆盖当前条目。 

 

无树物种代码（Non-tree species codes） 

在众多普查数据里，无树信息将使用一个物种代码定义数据。例如，代码

EPSTL代表一棵大树的空旷植树地点，或代码 STUMP 代表具一个树桩的潜在

植树地点。若需这些代码的报告，这些无树物种代码需在 Streets 中定义。 

1) 在物种定义（Define Species）窗口中，针对每一个无树物种勾选 Non-

Tree? column 的框框（box）。 

2) 接着，点击 Stocking 按钮。 

3) Stocking代码（Stocking Code）窗口将开启，从下拉式选单选择每个无

树代码并输入简要说明。 

4) 如果代码是指一个特定大小的地点，例如上述的 EPSTL，在 Tree Size字

段的下拉式选单选择大小。若大小未被指定，例如上述的 STUMP，选择

Undefined。 

5) 完成后，点击 OK。 

 

进行更改（Making Changes） 

你把普查数据上传到桌机，但发现一些错误。也许你的资料收集团队发现他们

用错 DBH的皮尺正反面，或误认 Acer negundo 为白蜡树（Ash tree）。此时更改

错误或在 Streets 中添加全新条目并不会太迟。 

 

信息库条目的添加或任何记录的更改可以透过 Input > Records 路径进行。 

1) 欲添加一个记录，点击 New。 

2) 欲编辑一个记录，反白欲更改的原记录，接着点击 Edit。一个类似于

PDA的窗口将开启，该窗口的各卷标页包含一般数据（General data）、

地点（Location）、树木信息（Tree Info）、管理（Management）、其它

（Other）和病虫害（Pest）。添加或更改记录后，点击 OK以关闭窗口。 

 

请注意，如果其中有错误，或更改时造成字段定义不连贯，一个红色的

小惊叹号将显示以提醒你检查。 
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复制记录（Duplicating records） 

Streets 有一个令人兴奋的新功能就是记录的复制功能，可透过 Input > Records

找到。当所有树木具有相似属性，此功能允许你快速添加相同的记录到信息库

里，避免繁琐的数据输入。此外，你还可以透过快速添加假想树木，观察城市

中的树木变化将带来什么效益与结构多样性。 

 

为避免一时添加过多假想树，最好的办法是使用新档名将你的项目另存新档，

让你能无后顾之忧地尝试不同改变。 

 

3) 选择 File > Save Project As，另存项目并以新檔名命名，例如

「MyTown_ WithALotMoreTrees（我的城市_多树版本）」。接着，选择

Input > Records，反白欲复制的记录，再点击 Duplicate。 

4) 一个弹跳窗口将询问你需复制多少份，输入所需的数字，点击 OK。 

5) 返回到 Reports 即可看到效益与都市林结构受到的影响。 

 

复查实地资料（Rechecking Data in the Field） 

某些状况下，你可能会发现你需回到现场复查普查条目。（例如，若你发现树木

的 DBH为 303 英吋，你知道这是错误的，但它是 30、3还是 33英吋？） 

 

使用智能型手机或平板计算机复查数据（Rechecking data with a smartphone or 

tablet） 

1) 选择 Tools > Work with Mobile，再点击标示 Submit Project 

Configuration 的按钮。 

2) 在下一个画面，勾选欲复查之树木旁的项目框，点击 Next。 

3) 输入建立项目时，所设定的电子邮件地址和密码。 

4) 点击 Finish。 

5) 开启行动装置上的电子邮件应用程序，点击从 i-Tree收到的电子邮件内

的网址链接。 

6) 登入后即可检视你所选择的树木。欲编辑树木数据，只需点击该树木并

循着画面指示进行。 

7) 记得经常提交你的数据！ 

 

使用 PDA复查数据（Rechecking data with the PDA） 

1) 选择 Tools > Work with PDA，再点击标示 Select Records to Transfer to 

the PDA 的按钮。普查清单将开启。 

2) 勾选相应记录条目旁的项目框并点击 OK。PDA与你的计算机联机且

ActiveSync 运行后，点击 Send Project Configuration to PDA 按钮。你的

记录现在应该出现在 PDA上了。 
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成果报告（Reporting Results） 

当你的普查数据已上传并编辑至满意，你可以在 Streets 上检视各式报告。它们

可以被分成四个主要类别：效益成本分析（Benefit-Cost Analysis）、资源结构分

析（Resource Structural Analysis）、替换值（Replacement Value）与病虫害分析

（Pest Analysis）。 

 

请注意：报告只提供你所收集的相关资料。举例来说，如果你没有在普查数据

内编制维护建议，维护建议报告将空白。同样地，若你没有为树木计划输入年

度成本信息（Annual Cost），成本收益率将不被计算。 

 

每个报告内有许多可检视的选项。透过选择相应的选项，每份报告可细分为公

有、私有或所有（公有和私有）树木。此外，透过选择相应的按钮，有些报告

可依物种或区域组织内容。选择完毕后，总结（Summary）报告类型将列出最

常见的物种（物种代表母群体的>1%）；而其它树木则归类为其它行道树

（Other Street Trees）。完整（Complete）报告类型列出所有编制到普查的树

木，依照占率与树木类型排序与分组。 

 

报告可以使用物种的学名或俗名与公制或英制单位。欲使用学名，选择 View > 

Scientific Name，学名选项勾选标记将在旁显示。欲返回到俗名，再点击该选

项一次，将选项标记移除。同样地，从 View > Metric Units 路径可将英制切换

为公制。完成这些更改后，点击 Refresh 即可显示新格式。 

 

效益成本分析报告（Benefit-cost analysis reports） 

Streets 计算都市林提供的环境与其它效益，但不会考虑每棵树木产生的经济效

益。报告中的效益与成本皆为初始估计，因为某些效益与成本为无形或难以量

化的（例如，心理健康、犯罪与暴力等的影响）。另外，对于它们的物理运作过

程与交互作用的有限了解使计算并不精确（例如，附着于树木叶片的空气污染

物经雨水冲刷至土壤）。树木生长率和死亡率的变化非常大，效益与成本皆取决

于现场的具体情况（例如，树种、生长条件、维护习惯等）。因此，Streets 在针

对特殊地点情况的有限了解下，提供一个概括性的统计──这个在合理范围内具

不确定性的统计仍将提供一个决策基础。量化及制定效益价值的方法，现记载

于已发行的 Tree Guides 连载刊物（在 www.itreetools.org的 Resources 中可获取

相关信息），该刊物符合 Streets 的气候地区。成本效益报告包含下列三种：年

效益（Annual Benefits）、管理成本（Management Costs）与年净效益（Net 

Annual Benefits）。这些皆可在 Reports > Benefit-Cost Analysis 路径找到。 

 

年效益（Annual Benefits）：可从左侧的下拉式选单取得七种报告。效益根据年

度量化，并以资源单位与美元呈现。若为样本普查，报告将显示标准偏差描述

不确定性的程度。完整普查数据的标准偏差则以 NA表示。 
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能源（Energy）：能源报告简述都市林对节约能源的贡献，像是冬季减少

的天然气用量（以十亿焦耳计算），以及夏季减少的空调电用量（以千瓦

每小时或十亿焦耳计算）。 

 

雨水（Stormwater）：雨水报告简述因树木节流而减少的年降雨雨水径流

（以加仑或立方米计算）。 

 

空气质量（Air quality）：空气质量报告量化黏附于树木表面的空气污染

物（O3、NO2、SO2、PM10），及电力使用减少导致的发电厂排放量减少

（NO2、PM10、VOCs、SO2，以磅或公斤计算）。另外也报告因 BVOC

（生物挥发性有机物质）而致的树木对空气质量的潜在负面影响。 

 

二氧化碳（Carbon dioxide）：二氧化碳报告简述二氧化碳在大气中的减

少量，因树木的封存、电力使用减少影响的发电厂排放量减少（以磅或

公斤计算）。该计算模型取用树木死亡与分解时排放的二氧化碳量，以及

维护保养树木所释放的二氧化碳量。 

 

碳储存量（Carbon stored）：上述报告量化二氧化碳的年度减少量，碳

储存量报告计算都市林中所有树木生命期间所封存的二氧化碳量（以磅

或公斤计算），所以它不应该计入二氧化碳数值，否则将导致重复计算。 

 

美观/其它（Aesthetic/other）：美观/其它报告展示有形和无形的效益，反

映于地产价值的增加（美元）。 

 

摘要（Summary）：摘要报告展示全年总能量（energy）、雨水

（stormwater）、空气质量（air quality）、二氧化碳（carbon dioxide）和美

观/其它（aesthetic/other）的效益。效益以美元/每棵树或整体总美元呈

现。 

 

管理费用（Management Costs）：与行道树管理相关的支出将以总支出及类别

各项支出呈现。结果以总美元、美元/每棵树和美元/每人呈现。 

 

年净收益（Net Annual Benefits）：全市的效益和成本将以各类别金额和总金额

呈现。净收益以效益减成本计算，并以效益成本比率（效益除以成本）呈现。 

 

资源结构分析（Resource structural analysis） 

资源结构报告提供都市林的实时概况与订立管理计划的必要信息。利用资源结

构和效益成本的统合报告，可以提供短期及长期的资源管理信息。这份数据报

告将有助于预测未来发展趋势及需面对的管理挑战，以实现都市林的永续性。 
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十四份基础报告可在 Reports > Resource Structural Analyses 路径获得。 

 

母群体摘要（Population Summary）：母群体摘要报告包括总结列表与完整物

种普查清单、总树木数量、各树木类型数量，与各 DBH预设分级数量。这些

报告协助对全市物种频率的基本了解，从管理区到 DBH分级皆有。请注意，

尚未匹配的树木种类代码将显示在报告底部的未匹配（Unmatched）分类。 

 

物种分布（Species Distribution）：物种分布报告根据物种组成的数据，使用圆

饼图与表格以数量百分比列出十种最常见物种。这份报告有助于了解物种优

势。 

 

相对年龄分布（Relative Age Distribution）：以 DBH等级分类的树龄数据，使

用图表与表格以数量百分比列出十种最常见物种。这些报告的重要性在于可用

以确定当前管理需要，以及预期整体数量与各物种个体老化将如何改变该需

求。一个群体中的树木年龄层分布将影响目前和未来的成本以及效益流动。不

均匀的群体让管理人员可以每年皆分配相同的年度管理经费，并确保整体树冠

覆盖的连续性。理想的分布状况以高比例的新移植树木抵消开发相关的死亡

率，而年长树木的比例也随年龄增长而下降。 

 

重要价值，IV 值（Importance Values，IV）：整体数量大于 1%的所有物种皆有

对应的 IV值透过表格呈现。Streets 的 IV值为三个相对值之平均（树木总量百

分比、叶片总面积百分比、树冠覆盖百分比），范围为 0到 100，100代表对该

物种的完全依赖。IV 值说明一个小区对特定物种的依赖度以提供功能性效益。

例如，某物种占整体数量的 10%，但因本身尺寸巨大而有 25%的 IV 值，表示

当此树木物种数量因病虫害或疾病而减少时，所造成的影响将比数字呈现的更

显著。 

 

状况（Condition）：树木的木材与树叶的状况，使用圆饼图和表格以数量百分

比呈现最普遍的物种。树木状况说明树木管理成效与特定地点状态下的树木相

对表现。 

 

相对表现指数，RPI（Relative Performance Index，RPI）：RPI涉及各品种的

状况并取之与其它品种互相比较；该信息使用表格呈现。高于 1的数值表示比

例上状况相对优良的物种。同样地，低于 1的数值则表示状况相对低于平均值

的物种。各物种的 RPI说明其对当地生长条件的适应度与表现。拥有许多状况

良好的树木的物种能在成本较低的情况下提供更高的效益，而树木表现普通或

不良的物种则反之。但请记住，RPI应与物种年龄数据比对，才能提供更完整

的概况。假如，某个物种多数为衰老、对城市贡献良多但接近生命尽头的树

木，该物种的 RPI值将偏低。 
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蓄积水平（Stocking Level）：根据你在 Stocking Codes 窗口所输入之数据，此

报告呈现蓄积水平及适宜种植地点的资料。蓄积水平报告可辨识优先度高的种

植区域，以及实施策略性植物购买与成本规划。 

 

维护建议（Maintenance Recommendation）：维护建议以表格形式展现。表格

内包含各物种的建议与所有建议的概论。成果可依 DBH分级或具特定建议之

前五物种列出。这些报告有助于让管理者了解行道树的实际修剪和维护需求。

这估算修剪程度的足够性，并提供有关城市行道树群体的风险与责任。有问题

的物种将被辨识，而成本规划变得容易。 

 

优先工作（Priority Task）：最紧要的维护工作根据用户所定义的类别显示。每

个优先工作将个别展示在所有工作概论的上方。这些报告依区域和 DBH分级

列出资料；各区域维护需求最高的五个物种也可被列出。这些报告有助于让管

理者了解行道树的实际修剪和维护需求。有问题的物种将被辨识，而成本规划

变得容易。 

 

土地利用（Land Use）：各土地利用的树木分布使用圆饼图和表格以数量百分比

呈现。这些报告有助于了解你的都市林在各土地利用类型的分布，并可用于比

较树木冲突、维护建议以及特定物种之问题种植地点的了解工作。 

 

位置（Location）：树木位置信息使用圆饼图和表格以数量百分比呈现。这些报

告可用于比较树木冲突、维护建议以及特定物种之问题种植地点的了解工作。 

 

冲突（Conflicts）：人行道损坏和电线冲突信息使用表格呈现。数据可依物种或

区域检视。这些报告有助于了解物种和管理区的当前及潜在基础设施相关冲

突。 

 

树冠覆盖（Canopy cover）：若你在城市信息（City information）窗口输入相关

数据，有关城市和街道的树冠覆盖程度将使用图表和表格以英亩/各区域及整座

城市呈现。这些报告有助于比较当前城市树冠覆盖及预期树冠覆盖程度。 

 

其它（Other）：若你于普查编制阶段收集了「其它（other）」数据，该数据将

使用表格按物种以数量百分比呈现。 

 

替换值（Replacement values） 

替换值在树木根据某种原因需被移除时，估算在现况下替换树木的总费用。替

换值根据树木与景观鉴定师评委会（Council of Tree and Landscape Appraisers，

CTLA）的物种评鉴指南，该指南使用树干公式法。CTLA 是广泛被树艺师用于

决定景观树木替换值的方法，其根据区域物种水平、状况、景观位置、树干截
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面积以及区域替换成本来考虑。各物种的物种水平、替换成本以及物种基本价

值均可在物种评鉴指南内的各参考城市中获得。因计算结果为近似值，替换值

只是群体的初步估计，而非树木之间的确定值。 

 

替换值报告有两种呈现方式：一是以普查中各物种的 DBH 分级，二是各区域

的 DBH分级。这些报告能在 Reports > Replacement Value 路径取得。 

 

病虫害分析（Pest analysis） 

病虫害分析报告使用 IPED程序收集的数据，评估都市林中现有和潜在的病虫

害威胁。这些报告可在 Reports > Pest Analysis 路径取得。该分析报告包含分析

树木记录的多方面选项，基于病虫害、症状和病症。Pest Review and Sign 和

Symptom Review 选项供你查询更详细的分析记录。 

 

摘要（Summary）：摘要报告使用表格呈现受病虫害影响的树木数量及百分比

记录。 

 

资料导出（Exporting Data） 

报告汇出（Exporting reports） 

报告导出有两个选项。主窗口上的 Export 按钮供你以三种格式汇出个别报告：

Adobe Acrobat（*.pdf）、Microsoft Word（*.doc）和 Rich Text Format（*.rtf）。

另外，你也可使用 Export Reports dialogue以 Excel（*.xls）格式汇出报告。 

 

欲从已开启报告窗口导出单一 PDF、Word或 RTF报告： 

1) 于已开启的报告窗口中点击 Export 按钮。 

2) 从 Save as type 下拉式选单中选择文件的保存类型（*.pdf、*.doc或

*.rtf）。 

3) 浏览至欲保存档案的位置，并输入代表此开启报告的档名。 

4) 点击 Save以完成。 

 

欲使用 Export Reports dialogue输出一个或多个 Excel 报告： 

1) 从 Files 选单中，选择 Export > Reports；Excel 对话框的导出报告选项

（Export Reports Selection）将开启。 

2) 选择 Browse 以找到欲保存报告的文件夹。开启的对话框将允许你根据

需求建立一个新文件夹。 

3) 勾选公有、私有或全部的项目框以选定群体子集。你可以选择任何或全

部子集；若复选，各选项将导出为单独文件。 

4) 报告有三个类别可供选择：效益成本报告（Benefit-Cost Reports）、整体

数量总结（Population Summary）与资源结构分析（Resource Structural 

Analysis）。对于各类别，你可以选择 All Reports或从单一个报告选择。



55 

 

各类别的个别报告将被一起分组并保存在相同文件中。 

 

普查数据汇出（Exporting inventory data） 

你也可以从 Streets 应用程序中将现存的树木记录以窗体格式（*.csv）或 xml 格

式（*.xml）输出。 

1) 点击 File > Export > Inventory Data 

2) 从 Save as type 下拉式选单中选择欲保存的文件类型（*.csv 或*.xml）。 

3) 3.浏览至欲保存文件的位置，并输入代表此记录的文件名。 

4) 点击 Save以完成。 

 

打印报告（Printing reports） 

Print按钮允许用户打印开启的任何报告。另外，你也可选择 File > Print执行

此动作。 
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附录一：随机街段工具书（Appendix 1: Random 

Street Segments Workbook） 

以下指示将帮助任何专业程度的人员创建随机 i-Tree Streets（STRATUM）样本

街段，用于实地资料收集。ESRI ArcGIS 软件将被使用；依据 ArcGIS 采用的版

本不同，指令也将有所修改。举例来说，美国人口普查的 TIGER 地图数据被应

用于整个城市。如欲使用于单一城市区域，请遵循各区域的基本指示。 

 

这些指示由两个基本步骤组成： 

1) 准备项目区域数据。 

2) 产生样本街段。 

 

完成上述步骤后，你已创建了下列： 

 关注区域的多边形（polygon）地图图层 

 随机街段线性（line）地图图层 

 

提示： 

 这些指令需在 ArcView 级别下使用 ArcGIS 的基本功能。无须使用任何

扩充软件。 

 进阶 GIS 使用者可主要关注下方列点条列的准备步骤概观，特别注意区

域名称与类型等区域的细节指示。 

 对于进阶 GIS 使用者：在区域基础分析时，创建完随机样本区段分层

后，迭加区域多边形分层以分割区域交界处。 

 若有需要，从地图记录提供者取得投影/坐标系统与地图单位信息。 

 AOI样本为大型多边形，如城市边界、公园区域或者是个别管理区。 

 ESRI shapefiles、覆盖或地理普查皆可使用。Shapefiles 非常容易上手。 

 建立良好的数据管理习惯：放置原始数据的文件夹、放置导出数据的文

件夹、有逻辑地命名文件夹等。 

 定期地在完成步骤期间，将你的作业保存为 ArcGIS *.mxd 专案。 

 下载数据时，你可能需关闭网页浏览器中的弹跳窗口。 

 

常用工具（Common tools）： 

 

开启项目（Open Project） 

 

选取（Select） 
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添加资料（Add Data） 

 

 

项目区域数据的准备 

概观（Overview）： 

 取得可呈现你项目的多边形关注区域（AOI）的 GIS 地图图层。 

 取得可呈现你项目的街道中心线的 GIS 地图图层。 

 在 ArcView、ArcEditor或 ArcInfo 级别下启动 ArcGIS 中的 ArcMap 应用

程序。 

 保存一个*.mxd 项目文件，并选择名称和档案位置。 

 加载 AOI和街道地图图层到视图中。 

 如有需要，请从现有的其它任何项目中，选择最能代表你项目区域的特

定多边形 AOI。 

 汇出选定的多边形 AOI。 

 如有需要，选择（或剪下）你 AOI中的街道线。 

 汇出所选择的街道线。 

 

结果（Results） 

 由一个或多个多边形组成的 AOI地图图层。 

 相关街道线地图图层。 

 

 

详细说明（Detailed instructions） 

1) 首先，你需取得描述你 AOI的 shapefile。可能的来源包含当地政府或学

校 GIS 部门或网站上的资源，像是 ESRI’s Free Data

（http://www.esri.com/data/free-data）: 例如，你可以使用美国人口普查

TIGER 地图资料，以获取县市的 shapefiles： 

a) 欲取得美国人口普查 TIGER 的县市地图资料，滚动至网页

上的「下载资料（Downloadable Data）」。 

b) 点击 Census 2010 TIGER/Line Data 连结。 

c) 在人口普查网页中，点击 Download by Type下方的

Download。 

d) 在「选择图层类型（Select a layer type）」下选择县市分

区。 

e) 在「2010年县市分区（County Subdivision 2010）」中选择

合适的州别。 

f) 选择合适的县市，点击 Download。 

http://www.esri.com/data/free-data
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g) 在系统提示时储存下载的档案并解压缩至你的作业目录或

容易再访的位置。 

2) 你仍需要道路中心线的 shapefile。欲从从美国人口普查 TIGER 地图数据

中取得这些数据，在网页上滚动至「资料下载（Downloadable Data）」。 

a) 点击 Census 2010 TIGER/Line Data 连结。 

b) 在人口普查网页中，点击 Download by Type下方的Web 

Interface。 

c) 在「选择图层类型（Select a layer type）」选择 Roads。 

d) 在「所有道路（All Roads）」选择适当的州别和相应的县

市。 

e) 在系统提示时储存下载的档案并解压缩至你的作业目录或

容易再访的位置。 

3) 启动 ESRI’s ArcMap 应用程序。 

4) 使用 Add Data 按钮，浏览并加载 TIGER County Subdivisions 和 Line 

Features – Roads 地图图层到当前窗口。若出现一个「未知空间参考

（Unknown Spatial Reference）」的讯息，点击 OK以移动到下一步。 

5) TIGER 城市分区数据由县市组成，通常包括多个多边形地点。使用

Select工具从屏幕上显示的多边形 AOI中选取你的特定多边形 AOI。细

读属性表或使用功能卷标的功能，以帮助你在必要时识别你的多边形

AOI。 
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6) 汇出选定的多边形 AOI到一个单独的地图图层，并添加导出图层到窗口

内： 

a) 鼠标右键点击 TIGER County Subdivisions 地图图层，并

选择 Data > Export Data。 

b) 确认 Export下拉式选单已设置 Selected features。 

c) 为多边形 AOI地图图层适当命名并保存。 

d) 系统提示时，点击 Yes 将导出的数据添加为地图图层到窗

口中。 

7) 查询 TIGER Road Lines 地图图层，以选择适合的采样街段： 

a) 在 Table of Contents（TOC）地图图层列表中，点击 Road 

Lines 地图图层以选择它（验证该地图图层在 TOC 中以勾

选，而可于窗口中检视）。 

b) 从主选单中，选择 Selection > Select by Attributes。 

c) 在开启的对话窗口内： 

 

确认 Road Lines 地图图层已从下拉式选单中被选择。 

 

确认所选方法的设置为 Create new selection。 

 

复制并贴上下方的指令句到窗口底部的查询框内： 

 

“MTFCC” = ‘S1200’ OR “MTFCC” = ‘S1400’ OR 

“MTFCC” =’C3061’ OR “MTFCC” = ‘C3062’ 

 

请注意：2010年的人口普查代码不同于一般通用的普查代码。此外，此查询内

容选择当地、县市、州道，但不包含州际公路或州际公路坡道，或私有道路、

街巷、四轮车专用道等。使用者可任意选择一组设定代码。 

 

8) 汇出选定的 TIGER 道路线子集到一个单独的地图图层，并添加到窗口

中： 

a) 鼠标右键点击 TIGER Road Lines 地图图层并选择 Data > 

Export Data。 

b) 确认 Export下拉式选单已设置为 Selected features。 

c) 将所选的街道线地图图层命名并保存。 

d) 系统提示时，点击 Yes 将导出的数据添加为地图图层到窗

口中。 

9) 为使抽样仅落在 AOI边界内，适当裁切街道区段。 

a) 透过 ArcToolbox > Analysis Tools > Extract > Clip 开启裁

切（Clip）工具。 
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b) 在输入（Input）功能下，选择适合抽样的已汇出街道区段

地图图层。 

c) 在裁切（Clip）功能下，选择欲导出的 AOI地图图层。 

d) 在输出（Output）功能类别下，浏览你的工作文件夹，替

裁切的道路图层命名，档名为.SHP（例如：myStreets_ 

Clip.shp）。 

e) 将 XY Tolerance框空白。 

f) 已裁切的道路图层将自动添加至 ArcGIS 的目录中。 

10) 从主选单中选择 Selection > Clear Feature 以取消选取多边形 AOI和

Streets 功能。 

 

结果（Results） 

适合抽样的多边形 AOI 地图图层和 AOI 相关街道线性图层。 

 确认多边形 AOI和 Streets 地图图层已加载至地图窗口。可能需使用鼠标

右键点击新的 AOI图层，并选择 Zoom to Layer。 

 鼠标右键点击地图图层列表中的新 AOI图层名称，并选择 Open 

Attribute Table 以确认你的多边形 AOI正确且使用属性字段，例如「名

称（name）」。 

 确认街道线已依多边形 AOI范围裁切。 

 

 
 

现在，这些街道线已经准备好采样。 
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街段样本生成（Street Segment Sample Generation） 

概观（Overview） 

 添加一个区域到 Streets 数据里。 

 计算 Streets 数据的随机数目数值。 

 从属性栏选取期望的街道区段样本数目。 

 导出街道样本数据和地图。 

 

结果（Results） 

 供实地采样的随机街道区段。 

 

详细说明（Detailed instructions） 

1) 在裁切过的 Streets地图图层中，右键点击 TOC中的 layer name开启表

格。 

2) 使用表格窗口左上角的 Table Options 按钮，添加一个 Double类型、名

为 RandomSeg 的字段至裁切完成的 Streets 表格。将 Precision和 Scale

字段留空。 

 

 

 

3) 右键点击新建的 RandomSeg 字段标题，并使用 Field Calculator使用

RND函数填满字段： 
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4) 填满字段后，鼠标右键点击 RandomSeg 字段标题，按照升序排序字

段。 

5) 滚动属性栏至街道区段的期望数目并选取之： 

a) 点击栏目中的任一单元格以检视 Record count box 的记录

数目。 

b) 找到期望的记录数目后，按住 Shift键，同时使用记录条目

左侧的灰色钮选取记录。 

6) 关闭表格窗口并返回至地图窗口，导出选定的 Streets 地图图层样本，并

将它们添加到窗口里： 

a) 鼠标右键点击已裁切的 Streets地图图层，并选择 Data > 

Export Data。 

b) 确认 Export下拉式选单已设置为 Selected features。 

c) 将所选的 Streets 地图图层命名并保存。 

d) 系统提示时，点击 Yes 将导出的数据添加为地图图层到窗

口中。 

7) 从主要工具栏中，选择 Selection > Clear Selected Features 取消选取

Streets 设计功能。 

8) 如有需要，开启新创建的街道样本属性栏，并导出记录供 Microsoft 

Excel 使用（用于打印等）： 
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a) 点击 Attribute表格 > Options 按钮 > Export > All 

records。 

b) 选择汇出为一个 dBase 档案，其可用于MS Excel。 

 

 
 

9) 如有需要，打印街段地图以供规划和现场使用： 

 

 

 

a) 在地图窗口中，以名称字段标签街段。 

b) 鼠标右键点击 TOC 上的标注以重新着色地图图层，改善其

视觉观感。 

c) 切换到 Layout 视图，并透过上方的 Insert 选单添加地图元

素，例如指北针与比例尺。 
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d) 从主要工具栏中，选择 File > Print，并选择合适的打印机

和纸张。 

e) 非必要选项（Optional）：选择 File > Export Map 保存地图

的电子副本。 

10) 非必要选项（Optional）：对于 AOI中的区域，添加区域多边形图层。将

街道样本区段与区域多边形重迭，以在区域间分割它们并分配各区段合

适的区域属性。 

a) 透过 ArcToolbox > Analysis Tools > Overlay > Intersect 开

启相交（Intersect）工具。 

b) 输出相交街段图层将具有街段的区域属性。 

c) 针对各区域使用 Select by location 功能，让各区域的街道

样本符合计算。 

 

结果（Results） 

在 LINE的地图图层中，随机街段样本的期望数目。 

街段样本属性数据的 MS Excel 文件。 

纸本化或电子化的样本区段地图。 
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附录二：错误排除（Appendix 2: Troubleshooting） 

群体概论报告显示错误的树木数字（或根本没有树木），但其它像是冲突等报告

显示正确的树木数量： 

在 New Project 对话框中，由于你错误选择，以致记录的 DBH分级记录。从

Input选单中，选择 Data Fields 并点击 DBH 选项。变更 Recorded By 选项到

Measurement。 

 

群体概论报告显示正确的树木数字，但它们没有分类到正确的 DBH分级： 

从 Input 选单中，选择 Data Fields 并点击 DBH 选项。变更 Measured In 选项

到正确的测量单位（英寸与公分）。 

 

有些记录显示物种代号，而非俗名或学名： 

你没有在定义物种（Define Species）对话框中，配对所有物种代码。选择

Input > Species，按照〈配对物种代码〉的指示。 

 

普查中的已知物种并未显示于群体概论报告内： 

请确定你已配对所有物种代码。选择 Input > Species，按照〈配对物种代号〉

的指示。请注意，群体概论报告有两种类型：（1）仅显示数量大于 1%的物种与

其它物种族群（概论）；（2）显示所有物种（完整）。 

 

选择蓄积水平报告时，我收到以下讯息：「你的普查中没有蓄积水平资料」： 

你没有设定物种代码供蓄积水平报告记录。在 Input选单中，选择 Species 并按

照〈配对无树物种代码〉的指示。 

 

群体概论报告有两个具相同名称的项目： 

你指定相同的物种名称给两个不同的物种代码。选择 Input > Species，滚动物

种代码清单直到你找到具相同物种名称的两个不同的物种代码。 

 

若该二不同物种代码实际上代表同一物种，你在 Streets 中更正记录。选择

Input > Records，在树木普查（Tree Inventory）窗口中变更个别记录。 

 

或者，若两个物种代号有相同俗名（如 QUWI = Quercus wislizeni（加州海岸

栎）= live oak（活橡树），以及 QUAG = Quercus agrifolia（加州檞树）= live 

oak），你可以经 Input > Species 变更俗名，使其更加精确（QUWI = interior live 

oak（室内活橡树），以及 QUAG = California live oak（加州活橡树））。 
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附录三：病虫害调查表（Appendix 3: Pest 

Protocol） 

如果你施行病虫害检测调查，但并未使用 PDA应用程序，你可以使用下方表格

编排你的数据，以使用 Streets 的进阶报告。你可以在此网站

（www.itreetools.org）底下的 Resources、IPED网页

（www.itreetools.org/iped/index.php），以及在线 Wiki PED 资源网址

（wiki.bugwood.org/IPED）找到更多关于此调查表的信息。 

 

 表一：病虫害调查表字段、分类与值。 

 



67 

 

 



68 

 

 



69 

 

 



70 

 

 

表 2（Table 2）為在普查 PestPest欄位中輸入的病蟲害 ID。病蟲害清單將頻繁地由

森林健康病蟲害專家更新。IPED使用者應經常選擇 Help選單下的 Update IPED選

項，確保使用者使用的是最新的病蟲害清單。 
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